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• S-NPP Stored Mission Data (SMD) Flow 
• S-NPP Data Access 
• S-NPP Environmental Satellite Processing 

Center (ESPC) Data Products 
• Data Product Tailoring  

Outline 
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• ESPC Data Processing 
• S-NPP Application Packets (APs) are downlinked at Svalbard and relayed to the ESPC within 

the NOAA Satellite Operations Facility (NSOF) in Suitland, MD 

• IDPS processes APs into Raw Data Records (RDRs), Sensor Data Records (SDRs), 
Environmental Data Records (EDRs), and Intermediate Products (IPs) [collectively known as 
xDRs] 

• NDE process the SDRs and EDRs from IDPS and generates additional data records 

• ESPC Data Distribution 
• IDPS distributes xDRs to the Comprehensive Large Array-data Steward System (CLASS) for 

archive, Government Resource for Algorithm Verification, Independent Test, and Evaluation 
(GRAVITE) for calibration and validation, Department of Defense (DoD), and NASA Science 
Data Segment (SDS) 

• NDE distributes xDRs to real time users:  National Weather Service (NWS), Authorized NOAA 
and NASA users, DoD, and European Organisation for the Exploitation of Meteorological 
Satellites (EUMETSAT), other international partners 

 

S-NPP SMD Data Flow 
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• CLASS – Electronic library of NOAA environmental data 
– xDRs, ancillary data, auxiliary data, and software release packages are archived 
– IPDS data delayed by 6 hours or more and normally made available to users within 24 hours 
– NDE generated data made available for archive when data is generated 
– Access:  via Internet (http://www.class.noaa.gov/) 

• NOAA’s S-NPP Data Exploitation Project 
– Serves data to near real-time user community via ftp-s 
– Access:  Submit NPP Data Access Request (DAR) form to NESDIS.Data.Access@noaa.gov 

• Global Telecommunications Service (GTS) via EUMETSAT 
– GTS is used for operational international exchange of meteorological data between NWP users 

• EUMETCast via EUMETSAT 
– EUMETCast is a satellite multicast system using Digital Video Broadcasting-Satellite (DVB-S) 

technology 
– Access:  Register for access via EUMETSAT 

• Direct Readout (X-band) 
– The Community Satellite Processing Package (CSPP) allows for access to S-NPP data in regional 

areas 
– Access:  Register and download software:  https://cimss.ssec.wisc.edu/cspp/download/ 

• Product Distribution and Access (PDA) 
– PDA is a future capability 

S-NPP Data Access 
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Critical Supplemental High Supplemental Low 
RDRs: 
 AMSR-2/3     ATMS        CrIS        VIIRS         

TDRs: 
AMSR-2/3     ATMS   

SDRs: 
AMSR-2/3     ATMS        CrIS          VIIRS 

EDRs: 
AMSR-2/3 
Sea Surface Temperature  

ATMS 
Land Surface Emissivity 

VIIRS 
Green Vegetation Fraction 
Imagery  
Ocean Color/Chlorophyll 
Polar Winds 
Sea Surface Temperature  
 
Blended 
SST (with VIIRS) 
SST (with AMSR-2) 
 

EDRs: 
AMSR-2/3 
Surface Type 

ATMS 
Imagery 
Land Surface Temperature  
Moisture Profile 
Temperature Profile 

CrIS 
Greenhouse Gases (CO, CO2, CH4) 

VIIRS 
Aerosol  Optical Thickness 
Aerosol Particle Size Parameter 
Albedo (Surface)  
Cloud Base Height 
Cloud Top Pressure 
Cloud Top Temperature 
Ice Surface Temperature 
Land Surface Temperature 
Quarterly Surface Type 
Surface Type 
Vegetation Health Product Suite 
Vegetation Indices  
 
Blended 
Land Surface Temperature (with 
VIIRS) 

RDRs: 
OMPS-N  

SDRs: 
OMPS-N   

EDRs: 
AMSR-2/3 
Cloud Liquid Water 
Imagery 
Precipitation Type/Rate 
Sea Ice Characterization 
Sea Surface Wind Speed 
Snow Cover/Depth 
Snow Water Equivalent 
Soil Moisture 
Total Precipitable Water 

ATMS 
Cloud Liquid Water 
Rainfall Rate 
Sea Ice Concentration 
Snow Cover 
Snow Water Equivalent 
Total Precipitable Water 

CrIS/ATMS 
Atmos. Moisture Profile 
Atmos. Temperature  Profile 

CrIS 
Infrared Ozone Profile 
Outgoing Longwave Radiation 

OMPS Nadir  
Nadir Ozone Profile 
Ozone Total Column 

VIIRS  
Active Fires 
Cloud Cover/Layers 
Cloud Effective Particle Size 
Cloud Mask 
Cloud Optical Thickness 
Cloud Top Height 
Sea Ice Characterization 
Snow Cover 
Suspended Matter 
 
Blended 
Biomass Burning (with VIIRS) 
Rainfall Rate (with ATMS) 
Rainfall Rate (with AMSR2) 
Total Precipitable Water (with 
ATMS) 
Total Precipitable Water (with 
AMSR2) 
Ozone (with OMPS NP) 
Ozone (with CrIS Ozone) 
Snow Cover (with VIIRS) 
Snow Cover (with AMSR2) 
Soil Moisture (with AMSR2) 
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S-NPP and GCOM-W1 Product Requirements 

Green text indicates product has been declared operational in ESPC 
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S-NPP ESPC Product Examples 
Microwave Integrated Retrieval System (MiRS) 
• MiRS provides temperature and moisture profiles, land surface 

temperature, land surface emissivity, snow water equivalent, snow cover, 
sea ice concentration, cloud liquid water, total precipitable water, ice 
water path, instantaneous rain water path, and rain rate products from 
microwave instruments in all weather and all surface conditions. 

• Formats:  NetCDF4  
• Coverage:  Global 
 
Vegetation Health Suite (VHS) 
• VHS provides vegetation health index (VHI), vegetation condition index 

(VCI), and temperature condition index (TCI) products which are used for 
drought monitoring, in global climate impact assessments, and to 
determine global crop production, fire risk, disaster mitigation, and food 
security. 

• Format:  NetCDF4 
• Coverage:  Global 
 
VIIRS Polar Winds (VPW) 
• VPW provides wind speed, direction, and height at high latitudes to be 

assimilated in numerical weather prediction models to improve model 
forecasts and improve hurricane track forecasts.  

• Formats:  NetCDF4, BUFR 
• Coverage:  Poleward of 65 degrees 
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ESPC Blended Products 
• Snow Cover (with VIIRS and AMSR-2) 
• Rainfall Rate (with ATMS and AMSR-2) 
• Total Precipitable Water (with ATMS and AMSR-2) 
• Ozone (with OMPS Nadir Profile and CrIS) 
• Soil Moisture (with AMSR-2) 

 

S-NPP ESPC Product Examples 

Blended Snow and Ice Products  Blended Soil Moisture 
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Data Product Tailoring 

• S-NPP data products can be tailored by NDE to meet user needs 
• Tailoring options include the following: 

– Aggregating 
– Reformatting 

• NetCDF4, GRIB2, BUFR, GeoTIFF 
– Resampling 
– Subsetting (i.e., thinning data files) 
– Subsampling 
– Remapping 
– Filtering 
– Compressing 

• GZIP, ZIP, ZLIB, and JPEG compression of files 
• Internal HDF5/netCDF-4 compression of data arrays 

– Applying World Meteorological Organization       
(WMO) Headers 

 
Filtered ACSPO SST 

Remapped VIIRS RGB 

Aggregated VIIRS Imagery 
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Sustain   •   Enable  •  Create  –  OSGS 

• S-NPP SMD flows from Svalbard to the ESPC and is 
distributed to NOAA’s long term archive and to 
various users/consumers 
 

• S-NPP SMD data can be accessed from archive and in 
near real time 
 

• S-NPP ESPC satellite data products include 
atmospheric, oceanic, land, and blended products 
 

• S-NPP ESPC satellite data products can be tailored to 
suit user-applications/needs  

 

Summary 
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Community Satellite Processing 
Package (CSPP) Polar-Orbiting 
Satellite Software and Products



What is CSPP?

CSPP (Community Satellite Processing Package) is a 
collection of software systems for processing data 
from meteorological satellites.  

The primary goal of CSPP is to support users who 

• Receive satellite data via direct broadcast; 

• Create Level 1B and higher level products and 
images in real time. 

Funding is supplied by JPSS and NOAA.
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NOAA Real Time Network

US DB Antenna Sites for SNPP

8/27/15
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NOAA Real Time Network

DB Antenna Sites and Status

8/27/15
4

DB Antenna Sites and Status!

8/27/15! NOAA Real Time Network! 5!

Station Operator Status Satellites 

Monterey NOAA Operational SNPP, Metop, POES 

Gilmore Creek NOAA Operational SNPP, Metop, POES 

Madison NOAA/CIMSS Operational SNPP, Metop, POES 

Honolulu NOAA/CIMSS Operational SNPP, Metop, POES 

Miami NOAA/CIMSS Operational SNPP, Metop, POES 

Mayaguez NOAA/CIMSS Oct 2015 SNPP, Metop, POES 

Corvallis Oregon State Univ. Operational SNPP 

New York City College Operational SNPP 

Greenbelt NASA Operational SNPP 
 



NOAA Real Time Network

DB Antenna Hardware

8/27/15
5

Honolulu Miami Madison

• NOAA antennas are Orbital Systems 2.4 or 3.0 meter dual X/L-band 
receiving SNPP, Metop, POES, Terra, Aqua, FY-3, and GCOM-W1.	  

• Other antennas are receiving SNPP, Aqua, and Terra. 



CSPP Software Philosophy

The CSPP software 

Creates useful products for the DB community, 

Includes up-to-date algorithms, 

Is pre-compiled for 64-bit Intel Linux (CentOS), 

Is easy to install and operate, 

Includes test data for verification, 

Runs efficiently on modest hardware, 

Has prompt user support.
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CSPP by the numbers

Satellites supported: 7 

Software packages: 10 

Sensors supported: 25 

Releases and updates: 29 

Registered users: 913 

Individual downloads: > 5000
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Satellite Multispectral Imager Infrared Sounder Microwave Sounder

Suomi NPP VIIRS 
SDRs (Level 1B), Images, 
Visualization, Clouds, 
Aerosols, Land, Ocean

CrIS 
SDRs (Level 1B) 
Atmospheric Profiles, 
Clouds, Visualization

ATMS 
SDRs (Level 1B), 
Atmospheric Profiles, 
Precipitation, Visualization

NOAA-18/19 AVHRR 
Clouds, Aerosols, Land 
Surface, SST, Visualization

HIRS 
Atmospheric Profiles

AMSU, MHS 
Atmospheric Profiles, 
Precipitation

Metop-A/B AVHRR 
Clouds, Aerosols, Land 
Surface, SST, Visualization

IASI, HIRS 
Atmospheric Profiles, 
Clouds, Visualization

AMSU, MHS 
Atmospheric Profiles, 
Precipitation

Terra MODIS 
Images, Visualization

N/A N/A

Aqua MODIS 
Images, Visualization

AIRS 
Atmospheric Profiles, 
Clouds, Visualization

AMSU 
Atmospheric Profiles, 
Precipitation, Visualization

CSPP Satellite/Sensor/Product Matrix
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CSPP Software Suite

9

CSPP Software Product Description

1. SDR VIIRS, CrIS, and ATMS geolocated and calibrated earth observations.

2. VIIRS EDR VIIRS imager cloud mask, active fires, surface reflectance, vegetation indices, sea surface 
temperature, land surface temperature, and aerosol optical depth.

3. HSRTV Hyperspectral infrared sounder retrievals of temperature and moisture profiles, cloud 
properties, total ozone, and surface properties.

4. Polar2grid Reprojected imagery (single and multi-band) in GeoTIFF and AWIPS formats.

5. Hydra Interactive visualization and interrogation of multispectral imagery and 
hyper spectral soundings.

6. MIRS Microwave sounder retrievals of temperature and moisture profiles; surface properties; 
snow and ice cover; rain rate; and cloud/rain water paths. 

7. CLAVR-x Multispectral imager retrievals of cloud properties; aerosol optical depth; surface 
properties; ocean properties. 

8. NUCAPS Combined hyperspectral infrared sounder and microwave sounder retrievals of 
temperature and moisture profiles, cloud cleared radiances, and trace gases. 

9. IAPP Combined infrared sounder and microwave sounder retrievals of temperature and 
moisture profiles, water vapor, total ozone, and cloud properties.

10. ACSPO Multispectral imager retrievals of sea surface temperature.



CSPP Software Suomi NPP NOAA-18/19 Metop-A/B Terra Aqua

1. SDR VIIRS, CrIS, ATMS Provided by 
AAPP

Provided by 
AAPP

Provided by 
SeaDAS

Provided by 
SeaDAS

2. VIIRS EDR VIIRS N/A N/A N/A N/A

3. HSRTV CrIS N/A IASI N/A AIRS

4. Polar2Grid VIIRS, CrIS, IASI Future version Future version MODIS MODIS, AIRS

5. Hydra VIIRS, CrIS, ATMS AVHRR AVHRR, IASI MODIS MODIS, AIRS

6. MIRS ATMS AMSU, MHS AMSU, MHS N/A N/A

7. CLAVR-x VIIRS AVHRR AVHRR MODIS MODIS

8. NUCAPS CrIS, ATMS N/A Future version N/A Future version

9. IAPP N/A HIRS, AMSU, 
MHS

HIRS, AMSU, 
MHS

N/A N/A

10. ACSPO VIIRS AVHRR AVHRR MODIS MODIS

CSPP Software/Satellite/Sensor Matrix
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CSPP Registered User Locations

11

February, 2015



1. CSPP SDR

CSPP SDR (Sensor Data Record) creates calibrated and 

geolocated earth observation products (Level 1B).

12

Heritage Developed by Raytheon and released as part of Algorithm 
Development Library (ADL). Source code is available in ADL.

Satellites/Sensors SNPP (VIIRS, CrIS, ATMS). 

Products VIIRS: M-band, I-band, and Day/Night Band SDR calibrated 
sensor data and geolocation files in HDF5 format. 
CrIS: Calibrated spectra and geolocation in HDF5 format. 
ATMS: Calibrated antenna temperatures and geolocation in 
HDF5 format.

Features • Multi-core support for faster processing. 
• Optional product aggregation and compression. 
• Automated download and installation of calibration LUTs. 
• Quicklook images



SDR Examples

13

SNPP 2015/04/08 19:10 UTC
CrIS MW

ATMS Ch 2

VIIRS M7

VIIRS M15

SNPP 2015/04/08 19:10 UTC



2. CSPP EDR

CSPP EDR (Environmental Data Record) creates atmosphere, 

land, and ocean products.

14

Heritage Developed by Raytheon and released as part of Algorithm 
Development Library (ADL). Source code is available in ADL.

Satellites/Sensors Suomi NPP VIIRS. 

Products Cloud Mask, Active Fires, Aerosol Optical Thickness, Suspended 
Matter, Sea Surface Temperature, Surface Reflectance, Normalized 
Difference Vegetation Index, Enhanced Vegetation Index, Surface 
Type, Land Surface Temperature, and Imagery in HDF5 format.

Features • Multi-core support for faster processing. 
• Optional product aggregation and compression. 
• Automated download and preparation of ancillary data. 
• Quicklook images.



EDR Examples
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Cloud Mask

Aerosol Optical Thickness

Sea Surface Temperature

Land Surface Temperature

SNPP 2015/04/05 18:26 UTC



3. HSRTV

HSRTV (High Spectral Resolution Retrieval) creates temperature, 

moisture, and trace gas profiles, and cloud products.

16

Heritage Developed at CIMSS/SSEC by Bill Smith, Elisabeth Weisz, and 
Nadia Smith.

Satellites/Sensors Suomi NPP CrIS; Metop-A/B IASI; Aqua AIRS. 

Products Temperature, moisture, and ozone at 101 pressure levels; surface 
skin temperature and emissivity; total column water vapor and 
ozone; CO2 amount; cloud mask; cloud top pressure and 
temperature; and cloud optical thickness in HDF5 format

Features • Common multi-sensor algorithm. 
• Single field of view retrievals. 
• Fast regression algorithm.



HSRTV Examples
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SNPP 2015/04/02 19:25 UTC 
Metop-B 2015/04/02 16:35 UTC

CrIS 
Mixing ratio 
500 hPa

IASI 
Mixing ratio 
500 hPa

CrIS 
Temperature 
500 hPa

IASI 
Temperature 
500 hPa



4. Polar2grid

Polar2grid creates reprojected imagery for single bands 

(grayscale) and band composites (RGB).

18

Heritage Developed at CIMSS/SSEC by Dave Hoese.

Satellites/Sensors Suomi NPP VIIRS; Terra/Aqua MODIS. 

Products Single band and multi-band images in GeoTIFF and netCDF 
formats (for AWIPS).

Features • Atmospherically corrected true color images. 
• Automatic adaptive enhancement for VIIRS Day/Night band. 
• User defined projection grids are supported. 
• Multiple input granules are composited on one output image.



Polar2grid Examples
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SNPP 2015/04/06 06:44 UTC 
SNPP 2015/04/06 20:07 UTC

VIIRS True Color

VIIRS M15 in AWIPS2

VIIRS DNB



5. Hydra

Hydra is an interactive GUI application for 

exploring multispectral satellite data.

20

Heritage Developed at CIMSS/SSEC by Tom Rink.

Satellites/Sensors Suomi NPP VIIRS, CrIS, ATMS; Metop-A/B IASI; Terra/Aqua MODIS; 
Aqua AIRS. 

Products Images in JPEG and KML format.

Features • Supports Windows, OS X, and Linux platforms. 
• Simple to install and use for training/classroom environments. 
• Multi-sensor comparisons (e.g., MODIS/VIIRS) are supported. 
• User-defined band combinations, scatter plots, and transects.



Hydra Examples

21

 6 

 
Figure 2:  Band 1 (.65 µm) (left panel) and Band 6 (1.6 µm) (center panel) reflectance images along 
with the scatter diagram created by plotting Band 6 versus Band 1 (right panel). 
 
4.  Now close the scatter diagram window and open the MODIS cloud product file from the same date 
and time (File-> File(s)-> MOD06_L2.A2014170.1605.051.2014171015558.hdf).  Choose 
Cloud_Phase_Infrared, and Overlay this field onto the Band 6 (1.6 µm) image.  The color coding for 
the Cloud Phase product is: 
 

Pink is Ice Cloud  
Blue is Water Cloud,   

 is possible Mixed Phase Cloud and  
Green is Undetermined. 

 
Toggle between the Cloud Phase and Band 6 image to see how the phase matches with the darker and 
brighter reflectances.  Do you think you could quickly determine cloud phase by looking solely at 
Band 6? What could this tell you about the maturity of a thunderstorm?  What are the limitations of 
using only Band 6 reflectances to determine cloud phase?  
 
5.  Now go back to the Band 31 (11.0 µm) data, change the enhancement to InvRainbow and note the 
location of the coldest clouds.  Display the Band 34 (13.7 µm) brightness temperatures into a new 
window.  Draw a transect through the coldest cloud tops in Band 31 (11.0 µm) as show in Figure 3 by 
selecting Tools->Transect and positioning the line by grabbing and moving the end points. Add the 
Band 34 (13.7 µm) brightness temperatures to the transect by selecting Tools->Transect in that image 
window. How do the brightness temperatures compare? Where are the temperatures similar and where 
are they different?  What is causing the differences?  Now display Band 35 (13.9 µm) and Band 36 
(14.2 µm) in new windows, and add transects for both.  What is causing the difference in the 
temperatures away from the cold clouds?  How could these bands be used to differentiate different 
types of clouds?  Close the transect window when you are finished. 
 

VIIRS Data Selector VIIRS M15 Image Window VIIRS I1 Image Window

MODIS Band 6 vs. Band 1 Scatter Plot

SNPP 2015/01/30 18:40 UTC 
Terra 2014/06/19 06:05 UTC



6. MIRS

MIRS (Microwave Integrated Retrieval System) creates 
atmospheric profile, precipitation, and surface products from 
microwave sounder data.

22

Heritage Developed at NOAA/NESDIS by Sid Boukabara, Chris Grassotti, et 
al.

Satellites/Sensors Suomi NPP ATMS; Metop-A/B AMSU, MHS; NOAA-18/19 AMSU, 
MHS.

Products Temperature and moisture profiles, total precipitable water, 
surface skin temperature and emissivity, rain rate, cloud liquid 
water, rain water path, ice water path, liquid water path, sea ice 
concentration, snow water equivalent, and snow cover.

Features • Multi-sensor common algorithm. 
• Physics-based retrieval. 
• Retrieves land and ocean products in all sky conditions. 
• Extensively validated and documented.



MIRS Examples
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SNPP ATMS Surface Skin Temperature with Rain Rate 
contours and isosurface of Rain Mass Profile

Metop-B 2015/03/30 02:01 UTC 
SNPP 2015/03/18 11:03 UTC

Metop-B AMSU/MHS 840 hPa 
temperature and water vapor



7. CLAVR-x

CLAVR-x (Clouds from AVHRR Extended) creates quantitative 
cloud, aerosol, and surface products from imager data.

24

Heritage Developed at NOAA/NESDIS/STAR and CIMSS/SSEC by Andy 
Heidinger, Andi Walther, Denis Botambekov, et al.

Satellites/Sensors Suomi NPP VIIRS; Terra/Aqua MODIS; Metop-A/B AVHRR; 
NOAA-18/19 AVHRR.

Products Cloud mask, type, fraction, and phase; cloud top height, pressure, 
temperature, and emissivity; cloud optical depth and effective 
radius; aerosol optical thickness; normalized difference vegetation 
index; sea surface temperature; all in HDF4 format.

Features • Multi-sensor common algorithm. 
• Product files include cloud and surface products, calibrated 

observations, and many ancillary data fields (user controlled). 
• CLAVR-x is the official NOAA cloud product for JPSS.



CLAVR-x Examples
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SNPP 2013/03/10 23:00 UTC

VIIRS False Color SST Ancillary Data Cloud Masked SST

Cloud Top Temperature Cloud Water Path Rain Rate



8. NUCAPS

NUCAPS (NOAA Unique CrIS/ATMS Processing System) retrieves 
atmospheric temperature, moisture, and trace gases from 
combined infrared and microwave observations.

26

Heritage Developed at NOAA/NESDIS/STAR by Chris Barnet, Antonia 
Gambacorta, Walter Wolf, Mark Liu et al.

Satellites/Sensors Suomi NPP CrIS/ATMS

Products Temperature, water vapor, and ozone profiles; trace gas profiles 
including ozone, carbon monoxide, methane, carbon dioxide, 
nitrous oxide, sulphur dioxide; infrared and microwave surface 
emissivity; cloud cleared radiances.

Features • Multi-sensor common physical retrieval algorithm. 
• Future versions will support Metop-A/B IASI/AMSU/MHS and 

Aqua AIRS/AMSU. 
• NUCAPS is the official NOAA sounding product for JPSS.



NUCAPS Examples
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SNPP 2015/04/03 19:07 UTC

Temperature Water Vapor Mixing Ratio



9. IAPP

IAPP (International ATOVS Processing Package) retrieves 
atmospheric temperature and moisture, total ozone, and cloud 
top properties from ATOVS sounder data.

28

Heritage Developed at CIMSS/SSEC by Hal Woolf, Jun Li, Chia Moeller, Tom 
Achtor et al.

Satellites/Sensors NOAA-18/19 HIRS/AMSU/MHS; Metop-A/B HIRS/AMSU/MHS.

Products Temperature and water vapor profiles; total column water vapor 
and ozone; cloud fraction; cloud top pressure and temperature; 
surface skin temperature and microwave emissivity. 

Features • Fast regression first guess; iterative nonlinear physical retrieval. 
• Also supports NOAA-15/16 (non operational).



IAPP Examples
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Metop-B 2015/04/02 16:35 UTC 
NOAA-18 2015/04/02 23:08 UTC

Metop-B Temperature at 850 hPa

Metop-B Water Vapor at 850 hPa

NOAA-18 Temperature at 850 hPa

NOAA-18 Water Vapor at 850 hPa



10. ACSPO

ACSPO (Advanced Clear-Sky Processor for Oceans) retrieves sea 
surface temperature from multispectral imager observations.

30

Heritage Developed at NOAA/NESDIS/STAR by Alex Ignatov, John Sapper, 
John Stroup, and Yury Kihai.

Satellites/Sensors Suomi NPP VIIRS; NOAA-18/19 AVHRR; Metop-A/B AVHRR; Terra/
Aqua MODIS.

Products Sea surface temperature, aerosol optical thickness; and clear-sky 
radiances.

Features • Multi-sensor common algorithm. 
• ACSPO is the official JPSS algorithm for SST.



ACSPO Examples
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2015/04/02

VIIRS SST 17:44 UTC MODIS SST 18:35 UTCAVHRR SST 18:31 UTC

VIIRS SST 2015/03/18 07:40 UTC



CSPP Summary

• CSPP continues to support the polar orbiting 

satellite DB community with a wide range of 

software and products supporting Suomi NPP, 

Metop, NOAA, and EOS satellites. 

• CSPP GEO now supports geostationary satellites. 

• We look forward to JPSS-1 in early 2017. 

http://cimss.ssec.wisc.edu/cspp/
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STAR JPSS 2015 Annual Science Team Meeting, August 24 - 28, 2015 
NOAA Satellite and Information Service  |  National Centers for Environmental Information 

NOAA’s National Centers  
for Environmental Information 

CLASS Access 



2 NOAA’s NATIONAL CENTERS FOR ENVIRONMENTAL INFORMATION 

Discussion Points  

• CLASS’s role verses NCEI’s role 
• What’s in CLASS 
• Access statistics and patterns 
• Types of users accessing data 
• Level of access services in CLASS 
• Other access 

 
 



3 NOAA’s NATIONAL CENTERS FOR ENVIRONMENTAL INFORMATION 

CLASS Role vs. NCEI Role 
• Comprehensive Large Array-data Stewardship System (CLASS) is 

managed by the NESDIS Office of Satellite Ground Services 
(OSGS).  CLASS’s current responsibilities include ingest, 
management, archival and access to its information holdings. 

 
• NOAA’s National Centers for Environmental Information (NCEI), in 

addition to providing similar services as CLASS, are responsible for 
data stewardship and user support of all information holdings in 
CLASS and in NCEI. 

 



4 NOAA’s NATIONAL CENTERS FOR ENVIRONMENTAL INFORMATION 

What JPSS Data can be Accessed? 
• There are 80 data families in CLASS. 

– 28 JPSS data families - ingest 
– 3 NDE data families listed under S-NPP  

• Each family of data may contain many data types.   
• Altogether there close to 150 JPSS datasets in 

CLASS.  
• The most popular are the SDR datasets. 

 



5 NOAA’s NATIONAL CENTERS FOR ENVIRONMENTAL INFORMATION 

Most Popular Datasets 

Satellite/instruments Period of record Volume 
archived  

S-NPP VIIRS xDRs 
 

2012 to current ~4400 TB 

GOES GVAR and pre-GVAR  
Imager datasets 

1979 to current ~335 TB 

POES/MetOp AVHRR and 
ATOVS Level 1b datasets 

1978 to current ~116 TB 

MetOp IASI datasets 2007 to current ~109 TB 



6 NOAA’s NATIONAL CENTERS FOR ENVIRONMENTAL INFORMATION 

Most Popular Datasets by Volume* 
*Based on ad hoc orders from Jan 2013 to Mar 2015 

VIIRS-SDRs 

GOES GVAR 

AVHRR 

IASI L 1C 

 23 CLASS data families with over 2 TB  delivered 
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Monthly Totals (TB) Accessed 

             Subscriptions                      Ad Hoc Orders 

S-NPP compression began 
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Total Archive Growth in CLASS  
Total archive volume in CLASS is around 11.5 PB  

S-NPP Launched Oct 2011 
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Who are the users of CLASS? 
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Step 1: Register for a user id account at 
www.class.noaa.gov (minimal information: your name, e-
mail address, a password) 
Step 2: Select from the drop down product menu and 
highlight a dataset 
Step 3: On the Search page make your selections 
(geographic region, start/end dates and times, and data 
types). 
Step 4: Determine if you need greater access or a 
subscription 

Note: Always provide your user ID when contacting the CLASS helpdesk 

How do I access data from CLASS? 

http://www.class.noaa.gov/
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Levels of Access Services  
CLASS order types: Average 

completion time 
Average File Limit Contact the CLASS 

Help Desk? 
Ad hoc orders  
(Use Search button to 
obtain inventory) 

Usually within 12 to 
24 hours   

Up to 500 files No 

Large orders  
(use Quick Search 
button to skip 
inventory) 

24 to 48 hours 1000  No 

Block orders 
(use Quick Search 
button) 

> 48 hours 3000 Yes 

Subscription  
(standing orders) 

< 6-7 hours No limit  Yes 
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Proposed Access Increases to JPSS Data 
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Levels of Access Services (2) 
CLASS provides daily tar files containing publicly 
available S-NPP products for easy anonymous FTP 
download at:  ftp://ftp-npp.class.ngdc.noaa.gov/ 
 
• Most recent 85 days  
• 80 datatypes (including Geolocation files) 
 Newly added NDE_L2 NUCAPS and MIRS 
      and NDE_Daily Polar Winds  

• Data are compressed and “tar”-ed by datatype 
• Sorted by Date (YYYYMMDD)/Data Family/Data 

Type 
• Includes manifest files (xml format) 
• No registration required for access 

ftp://ftp-npp.class.ngdc.noaa.gov/
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Other Access Under Development 
(Machine to Machine) 

CLASS Core 
System 

Machine-to-
Machine 
Interface 
(RESTful 
Services) 

AccessService 
(SOAP-based 

Services) 

NCEI- NC 

NCEI- CO 

NCEI- MD 

Users 

Users 

Users 

CLASS Backend CLASS Middleware Users 

CLASS Frontend (Web) 

The M2M API implements a set of RESTful web services for searching, ordering, 
and order status querying of CLASS’s information holdings.  
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For technical questions regarding access in CLASS: 

class.help@noaa.gov 
axel.graumann@noaa.gov 

  
Tutorial on using CLASS: 

CLASS Access tutorial - on CLASS Home Page in the News section 
 
 

Assistance and Support 
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CLASS Home Page 
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Questions? 



GRAVITE 1 

   Overview of the JPSS GRAVITE System 

Peyush Jain 
DPES Development Manager 

NASA GSFC Code 586 
 

Gyanesh Chander 
DPES Manager 

NASA GSFC Code 586 
 
 

JPSS Ground Project 



GRAVITE 2 

GRAVITE 

• GRAVITE stands for “Government Resources for Algorithm 
Verification, Independent Test and Evaluation” 

• GRAVITE is the JPSS Ground System’s Calibration/Validation Node  
– Data center class hardware housed at the NOAA NSOF  

• GRAVITE services facilitate: 
– Algorithm Integration and Checkout 
– Algorithm and Product Operational Tuning 
– Instrument Calibration 
– Product Validation 
– Algorithm Investigation 
– Data Quality Support and Monitoring  

• Science algorithms are provided by NOAA STAR 



GRAVITE 3 

• Four subsystems: 
– IPS (Investigator-led Processing System) 

• In-house developed. Production system, operator managed. Consists of 
Ingest, Automated Processing, and Distribution components. Runs PGEs 
(Product Generation Executable) for Cal/Val and Data Quality Monitoring  

– G-ADA (GRAVITE Algorithm Development Area) 
• Interface Data Processing Segment (IDPS) compliant development and 

testing platform for JPSS algorithms and Look-Up-Tables. After verification, 
proposed changes are sent to CGS as Algorithm Change Packages (ACP) for 
integration 

– ICF (Investigator Computing Facility) 
• Science tools and libraries, personal user space, access to data, and 

computing power are provided to run CPU and memory intensive 
applications. Provides access to subscribed data 

– GIP (GRAVITE Information Portal) 
• Coordination and knowledge sharing for GRAVITE projects through Blogs, 

Wikis, Action trackers, etc.  
 

GRAVITE Subsystems 
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GRAVITE Purpose and Unique Features  

GRAVITE provides a unique environment to support the Calibration/Validation and 
Data Quality Assessment of JPSS mission data products: 

Category Description Unique Feature(s) 
Distribution Fast access to IDPS created data products (anticipated 

to be on the order of minutes in Block 2.0) 
Direct interfaces to IDPS and STAR 

Cal/Val tools Automated and ad-hoc tools that cal/val users use for 
algorithm analysis and update 

Product Generated Executables and 
Algorithm Support Functions 

IDPS “Clone” The G-ADA provides an instance of the IDPS available 
for algorithm change testing, science investigation, 
and data quality investigation 

Installation of latest IDPS code in 
identical SW environment on similar 
hardware 

Access to 
baselined data 

Access to the latest baselined Processing Coefficient 
Tables (PCTs) and Look Up Tables (LUTs) 

Access to ICF with the latest 
updated tables provided to IDPS 

DQA offline Data Quality Assurance Offline Tools DQA offline in GRAVITE takes 
advantage of the performance 
features as well as proximity to 
near-real time data flows 
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GRAVITE Technical Specifications 

Operations Environment 
• 760 TB storage 
• 3 IBM General Parallel File System (GPFS) clusters serving: ICF, IPS, G-ADA, G-ADA Block 2.0 
• 35 IBM 787x series blades. Each blade has 12 or 16 CPU cores, 128 GB memory, 4 network interfaces 
• 2 Dell R710s running VMware, hosting 11 virtual machines 
• ICF and IPS use Red Hat Enterprise Linux 6.6, G-ADA uses AIX 6.1 

 
Test/Development Environments 
• 434 TB storage 
• 1 IBM GPFS clusters serving: test, test2, test3 
• 13 IBM 787x series blades. Each blade has 12 or 16 CPU cores, 128 GB memory, 4 network interfaces 
• 4 IBM blades running VMware, hosting 17 virtual machines 
• ICF and IPS use Red Hat Enterprise Linux 6.6 

 
Network 
• 12 IBM racks 
• 10 GE Cisco Nexus switches, computing to storage 
• 1/10 GE Cisco and IBM switches, computing to backbone 
• 1/10 GE interfaces between Cisco ASA next-generation firewalls (558x series) and mission partners and internet 
 
Data Flow 
• 2.2 TB/day ingest from IDPS 
• 0.7 TB/day ingest from CLASS  
• 1.2 TB/day ingest from G-ADA 
• 2.6 TB/day RIPs distribution to NASA SDS and CLASS 
• 1.3 TB/day data distribution to Cal/Val community 
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Login 

https://gravite.jpss.noaa.gov/ 
 

https://gravite.jpss.noaa.gov/
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Search 

 
 
 
 
 



GRAVITE 8 

 
 
 
 
 
 
 
 

Search Results 

• Click on a file to download it immediately to your local machine 
• Select multiple files and click Add to Bag to download multiple files 
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Download Bag 

• Files added via Add To Bag are available under Download Bag Tab  
• Download files as a zip on your local machine 
• Files staged on GRAVITE, accessible from ICF under:  
      /inv/data/subscriptions/<username>/<directory name> 



GRAVITE 10 

Subscriptions 

 
 
 
 
 
 
 
 

• Select subscription criteria and  
      provide subscription name  
• Review and manage subscriptions  
      under Subscriptions Tab 
• Files staged on GRAVITE, accessible from  
      ICF under:  
      /inv/data/subscriptions/<username>/<subscription name> 

 
 



GRAVITE 11 

Pull/Push Data 

• Pull 
– Subscribed data can be pulled by connecting to gravite.jpss.noaa.gov via 

RSYNC, SFTP protocols 
– Data is available under /subscriptions/<username>/<subscription name> 

• Push  
– Dedicated Line 

• Need Inter-Connection Security Agreement (ISA), Interface Control Document 
(ICD), Interface Requirements Document (IRD), Service Level Agreement (SLA) 

• 10G dedicated line established between GRAVITE and STAR. In case of STAR, 
ICD and IRD are approved. ISA and SLA are pending NOAA security signatures  

– Over internet 
• Need to add GRAVITE L4 requirement to ensure adequate resources are 

available 
• Work with GRAVITE operators to add a new push subscription or enable 

existing subscription for pushes 
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Prelaunch J1/NPP data 

• Prelaunch J1/NPP data is obtained directly from the factory sites where 
the instruments are tested. GIP hosts this data under instrument 
projects  
– https://gip.jpss.noaa.gov/projects/<project> 
– J1 Projects: j1cris, j1omps, j1viirs, j1atms 
– NPP Projects: npp_cris, npp_omps, npp_viirs, npp_atms 

• Instruments:  
– CrIS (pulled from Excelis) 
– OMPS (pulled from Ball Aerospace) 
– VIIRS (pushed from Raytheon) 
– ATMS (manually uploaded by test conductors) 

• Access: 
– Download data from projects using RSYNC, SFTP by connecting to 

gdata.jpss.noaa.gov 
– From ICF, data is available under /var/www/data/<project> 
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System Status 
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Ingest and Orbit Statistics 

• Recent tests show, at times GRAVITE  
      test system ingested files at  
      828,000 files/day and  
      volume at 14.2 TB/day 
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Data Quality Tools 

DQA Offline Tools 
 

• Gap Minder  
• Trend Data Collector (TDC) 
• Product File Quality Analyzer (PFQA) 
• Sensor Quality Analysis Product 

Generations Executables (PGEs) 
• Number Extractor (N-Extract) 
• Integrated Calibration/Validation System 

(ICVS) Lite 
• Data Quality Notification (DQN) Reporter 
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PGE Control 
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• GRAVITE is currently in operations and has been successfully 
supporting SNPP since its launch in Oct 2011  

 
• GRAVITE has evolved as a system with increased performance  

– Robust, stable, reliable, maintainable, scalable, and secure 

– Supports development, test, and production strings 

– Uses open source software 

– Compliant with NASA and NOAA standards 

Summary 
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GRAVITE 

Backup 
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• New GRAVITE account request 
– Erica Handleman: erica.handleman@nasa.gov  

• Please cc operations mailing list: OPS-GRAVITE-DPES-JPSS@lists.nasa.gov 
 

• Please contact GRAVITE 
– Support at gravite.service@noaa.gov for system access issues 
– Operators at ops-gravite-dpes-jpss@lists.nasa.gov for all other issues 

 
• GRAVITE Web Interface: 

– https://gravite.jpss.noaa.gov 
 

 
 

 

Help 

mailto:erica.handleman@nasa.gov
mailto:OPS-GRAVITE-DPES-JPSS@lists.nasa.gov
mailto:gravite.service@noaa.gov
mailto:ops-gravite-dpes-jpss@lists.nasa.gov
https://gravite.jpss.noaa.gov
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• The following documents are available at: 
https://gip.jpss.noaa.gov/projects/gip_user/dmsf 
– GV4.0 Training Slides (GV4.0 Training Slides.pdf) 
– GRAVITE User Guide (GRAVITE User Guide.pdf) 
– GRAVITE DQE Guide (GRAVITE DQE Guide.pdf) 
– PGE Integration Form (GRAVITE PGE Integration Form.pdf) 
– PGE Details document (PGE details.xlsx) 
– DQA Configuration Details (dqConfig.html) 
– Documentation for the DQA Configuration (DQA Configuration Report.docx) 

 
• Documents on individual Sensor Quality tools are available in: 

https://gip.jpss.noaa.gov/projects/jpssdpa_external/repository 
under Algorithm Support Function (ASF), Cal/Val and Data Quality 
Monitoring folders  
 

 
 

Documentation 

https://gip.jpss.noaa.gov/projects/gip_user/dmsf
https://gip.jpss.noaa.gov/projects/jpssdpa_external/repository
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IPS High Level Functions 
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Accessing Non-NOAA Data: 
Sentinel and Himawari  
Frank Monaldo*/Michael Soracco# 

NESDIS/STAR/SOCD/MECB 
Frank.Monaldo@noaa.gov 

Michael.Soracco@noaa.gov 

 
*IPA from Johns Hopkins University APL 

# DMT for NOAA/NESDIS/STAR/SOCD 

 

mailto:Frank.Monaldo@noaa.gov
mailto:Michael.Soracco@noaa.gov


 
NESDIS Mission Statement 
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“…NESDIS is dedicated to providing timely 
access to global environmental data from 
satellites and other sources to promote, 
protect, and enhance the Nation’s economy, 
security, environment, and quality of life.” 

“Continue to lead the effort with other 
agencies and countries in establishing a 
global observing system to meet the 
world’s information needs for weather, 
climate, oceans, and disasters.” 

Use of non-NOAA data sources is consistent with 
and necessary to complete the NESDIS Mission. 



 
Non-NOAA Data 
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• NASA and other agencies. 
• Other countries. 
• Varying data policies. 
• Differ degrees of relevance to NOAA. 
• Here we focus of accessing Sentinel data 

from Europe and Himawari data from 
Japan. 
 



 
Copernicus Program 
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• Europe’s effort to  provide necessary 
environmental data. 

• Complements US efforts. 
• Data is free and open. 
• Long-term program, slated to spend $10 

billion to 2020 and significantly more out 
to 2030. 

• The US just needs to apply sufficient 
resources to say “Yes.” 
 



 
Copernicus Program 
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• Sentinel-1: SAR Imagery 
• Sentinel-2: Multi-Spectral 

Imaging (Landsat) 
• Sentinel-3: Ocean and 

global land monitoring 
(VIIRS/MODIS) 

• Sentinel-4: GEO 
atmospheric composition 

• Sentinel-5: LEO 
atmospheric composition 

• Sentinel-6: LEO altimetry 



 
2014-2017 Sentinel Data 
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• Sentinel-1: 
• C-band Synthetic Aperture Radar Imagery for wind speed, oil spill, ship detection, 

ocean wave spectra etc. (10-50 m resolution, 80-400 km swath) 
• 1A Launched April 2014 
• 1B  Launch Early 2016 

• Sentinel-2: Multi-Spectral Imaging (Landsat) 
• 13-channel multi-spectral imagery (443 – 2190 nm), 10-60 m resolution, 290 km 

swath 
• 2A Launched June 2015 
• 2B Launch Mid- 2016 

• Sentinel-3: Ocean and global land monitoring (VIIRS/MODIS) 
• Instruments: 

• SLSTR (Sea and Land Surface Temperature Radiometer) , 0.5-1 km resolution, 
1400 km swath. 

• OLCI (Ocean and Land Color Instrument.) 21 bands, 300 m resolution, 1270 
km swath. 

• SRAL (SAR Altimeter). 
• 3A Launch Nov 2015 
• 3B Launch 18 months after 3A ~Early 2017 

 



 
Data for International Partner 
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• Special portal for “International Partners.” 
• Same interface as the open portal. 
• NOAA, NASA and USGS are negotiating the high-

level and technical arrangements. Expect 
conclusion in the fall. 

• Data has lower latency than public portal. 
• On Internet-2-Geant for higher bandwidth and 

less competition with general Internet traffic. 
• EUMETSAT Level-2 Ocean Products through 

multicast 



 
Open Sentinel Data Hub 
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https://scihub.esa.int/dhus/ 

Anyone can register for free access. 

• Free and open data. 
• Access to all Sentinel data. 
• Interactive data selection. 
• Scriptable calls using https to pull data within 

different time and location windows.  



 
Sentinel Data Rates 
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Data rates (TB per day) FY16 FY17 

Sentinel-1A (Launched) 0.68* 0.68 0.68 

Sentinel-1B (April2016) 0.68 0.68 

Sentinel-2A (Launched) 1.66 1.66 1.66 

Sentinel-3A (OCT2015) 2.62 2.62 2.62 

Sentinel-2B(mid-2016) 1.66 1.66 

Sentinel-3B (18 months after Sentinel-3A): 2.62 2.62 
Total 9.92 4.96 9.92 

* Currently pulling at medium resolution, approximately 300 GB/day. Only  pulling  
polar regions and coasts of the US. 



 
Nominal Data Flow For Sentinel Data in Pre-PDA Era 
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Nominal Data Flow For Sentinel Data PDA Era 
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Sample Sentinel-1A Wind Retrieval 
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Sentinel-1A Coverage: 12 day cycle  
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Sample Cost Savings 
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NOAA/NOS Great Lakes Forecast, Sentinel-3 
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NCCOS planning on Sentinel-3 OLCI for improved 
Lake Erie HAB Forecasting and water quality 
monitoring 

•   300m spatial resolution 
•   Spectral bands for product generation 
•   Relieves single-point-of-failure  



 
Himawari 8/9 

• Advanced Himawari Imager (AHI) 
 

Wave 
length 
(µm) 

Himawari-8/9 
MTSAT-1R/2 Band 

number 

0.47 1 1     

0.51 2 1     

0.64 3 0.5 1 

0.86 4 1     

1.6 5 2     

2.3 6 2     

3.9 7 2 4 

6.2 8 2 4 

6.9 9 2     

7.3 10 2     

8.6 11 2     

9.6 12 2     

10.4 13 2 4 

11.2 14 2     

12.4 15 2 4 

13.3 16 2     

 : the sensor has its observing band. 
Number : horizontal resolution (in [km]) at sub-satellite point. 
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• Present: 
• 350GB/Day all channels of AHI HSD data 
• Every full disk, 10 minutes  
• Users are NWS and NAVO.    

• Planned: 
• NESDIS/OSPO to set up H-8 data in McIDAS at the current MTSAT 

temporal/spatial resolution and bands.  
• Replacement of MTSAT hoped to be in place by Dec 2015, but may be 

delayed due to other OSPO priorities.  
• Users approved for MTSAT on GEODist servers will be granted access to H-8 

McIDAS. 
• Access to full resolution H-8 data (NetCDF) will only be through 

PDA  (~2016).  (Existing users will be contacted around Jan 2016 to re-
validate access for PDA. ) 

• Himawari-8 SST data from either STAR or from Australia BoM to replace 
MTSAT in our blended SST product.  

 



 
Himawari 8/9 Data Flow Pre-PDA 
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Himawari 8/9 Data Flow PDA 
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Conclusions 

• Other countries are providing increasing 
volumes and quality of Earth environmental 
data. 

• In many cases, these data complement NOAA 
polar-orbiting and geostationary data. 

• NESDIS is beginning to deal with Sentinel and 
Himawari data. 

• Need to keep these data in mind when 
planning for resource requirement for data 
acquisition, processing, and distribution. 
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Satellite Comparison for cyano 
applications 

Clouds take out 1/2 to 2/3 of imagery 
Some sunglint is not a problem for our algorithms 
Minimum resolution, 3 pixels across (2 mixed land/water) 
 

Satellite Spatial Temporal Key Spectral 

MERIS (2002-12) 
OLCI Sentinel-3 2015 

300 m 2 day   10 (5 on red edge) 

MODIS high res 
Terra 1999;  Aqua 2002 

250/500 m 1-2 day 4 (1 red, 1 NIR) 

MODIS low res 
& SeaWiFS  

1 km 1-2 day 7-8  (2 in red edge) 

Landsat  30 m 8 or 16 day 4 (1 red, 1 NIR) 

Sentinel-2 
(2015) 

20 m 10 day (5 day with 2nd 
satellite in 2017) 

5 (1 red; 2 NIR, 1 in 
red edge) 

OK good good 

OK 

OK 

good 

good 

good 

good 

poor 

Potential with 2 

poor marginal 

potential 

marginal 



Satellite bands and sensitivity to materials 
in the water 

MERIS 

MODIS 

SeaWiFS 

Landsat 

everything    sed/pigs      PC    chl  alg/sed    scum/sed 

Landsat TM 



Intense blooms in water, red/NIR bands provide 
discrimination 

MERIS bands 
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Extensive use of MERIS for monitoring  
(Lake Erie example). Algorithm moved to 1 km MODIS in 2012.  

MERIS 300 m MODIS 1 km 
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